Macintosh

Mac OS

Follow these instructions very closely and
do not skip any patrt.

The following Instructions will allow you the ability to dial into Midcoast Internet Solutions with
your Mac.

Midcoast Internet Solutions will not be held responsible for any problems caused by this
configuration.

Minimum requirements:

1.)A basic working knowledge of the Macintosh computer is required. Basic skills such as double — clicking, click —
and —drag, window scrolling, as well as basic file and menu operations are necessary. For those who need
help, there are two Apple tutorials included in the folder titled “Macintosh Tutorials: with the software.

2.) A Macintosh or Mac compatible computer with a Motorola 68030 processor or higher (LC Il or higher;
Power PC is preferred) and at least 16 megabytes of physical RAM installed. System 7.5.3 or higher must
already be installed in your computer.

There are three steps that need to be taken to enable your computer to connect to the Internet with Midcoast
Internet Solutions. Simply follow the steps one at a time and within minutes you will be “Surfing the Net”.

NOTE Much of the software included needs to be installed. To install the software, you simply double — click on the
install icon and follow the directions as they appear on the screen. If you have Mac OS 8 or higher on your
computer, you probably already have all the necessary software installed on your computer, simply follow the
steps and you'll be online in a few minutes.
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Step 1

Open your Control Panels folder (Hint — Pull down the “Apple” menu to “Control Panels” and let go)(later
systems will have a sub menu on the side) and locate the control panel named “TCP/IP” and open it by double —
clicking onit. If you are unable to locate the TCP/IP control panel, proceed directly to Troubleshooting

ltem 1.

Position the cursor over the small arrow in the window “Connect via:” (see Window A) and hold down the
mouse button, select “PPP” from the pop — up menu. If “PPP” does not show, go directly to the troubleshooti
section and see Item 2.

Using the mouse select “Using PPP Server” from the “Configure:” menu.

Click the mouse one time in the window titled “Name Server Addr.” And then type in the following numbers,
10.0.0.1 and then in the box titled “Search domains” type in “midcoast.com” (without quotes)

Window A
S=———————— TCP/IP
Connect wia: | FFF - I
— Setup
Configure | l=ing FPF Serwver bl I

IF address: < will be supplied by serwver *
Subnet mask: < will be supplied by server »

Fouter address: < will be supplied by server

Search domains:

Marne serwver addr.: |10.0.0.1 rridcoast com
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Step 2

Open the Control Panels folder and locate the control panel named “MdaMerdd{v B) if you are unable to locate
the modem control panel, proceed directly to “Troubleshooting” Item 2.

Make sure that the correct port is selected for the modem in the “Connect via” window. Then select your
modem from the pop-up menu by positioning the cursor over the black arrow in the window titled, “Modem:”

and holding the mouse button down, then select your modem. If your modem does not show, go directly to
“Troubleshooting” Item 3.

Window B
Connect via: | Modern Port |
— Setup
Madern : | US Robotics Univerzal N‘ﬂ
Sound : () On {_) Off
Dialing: () Tane {_) Pulze
|:| lgnore dial tone
2

Your window should look similar to the window above, with your modem showing in the “Modem:” window.
If you are not sure what brand, model and speed your modem is you may have to check with your computer manuf
turer to find out what modem is installed. This is primarily a situation that occurs with internal modems.
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Step 3

Open the Control Panels folder and locate the Control Panel named "RiRiEbdW C) if you are unable to locate the
PPP control panel, proceed directly to page 4, “Installing Internet software,” Item 2.
Note: If you are using System OS 8.5 or an iMac, PPP will be called “Remote Access”

In the “Name section, enter your user ID for midcoast.com. Do Not enter your full name here, only your user
ID. Then enter your password in the “Password” sectdddTE: The password will show as black gotslow
select a phone number appropriate for your area and enter it in the “Number:” section.

When entering user name do not include “midcoast.com” as part of the name entry. If your email address is
“lohndoe@midcoast.com” then your user name is “johndoe”.

When entering information on this screen make sure you are using lowercase letters, and no spaces.
Incorrect: John Doe (capitol letters and a space)

Incorrect: JohnDoe (capitol letters)
Correct: johndoe@midcoast.com

Window C

Connect via: Modem

— Connection

IEI Registered User l:::l Guest

Marne : [User ID goes here

Fazszword:

E Save password

Murnber : | lacal phone number

— Status

Idle.

4 [ Options... | || Eunneﬁ;]]
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Please refer to the MIS Telephone Directory and Contact Information for the list of telephone numbers to dial.

That'’s it, now make sure your external modem is turned on and connected and click on the “Connect” but
Your modem will dial and connect to Midcoast Internet Solutions. (If you have an internal modem it should always
on with the computer.)

Note: If you are unsure if the number you have chosen is a local call for you then you must refer to your 1
phone directory or call your local phone company. Midcoast Internet Solutions accepts no responsibility for telef
charges incurred from the use of customer’s modénssthe customers esponsibility to make sue that the
number(s) they dial with their modem for internet connectivity is/are a local call for them.

Now you are online and ready to open the software you wish to use. Please open the Internet Software f
and refer to Using Internet Software for information on the software included. Most software will need to t
installed on your computer prior to our usingilease note that the softwa is provided free of charge and
comes without any warranties of any kind. Pleasesad all appropriate information pr ovided by the
software manufacturer prior to installing any software.

Installing the software.

In most cases the installation of the software provided on the MIS CD-ROM will be a simple matter of double-clickin
the installer icon. In a few minor cases (when no installer icon is present) the installation is a simple matter of draggin
and dropping the program folder. “Newswatcher” is a good example of this. The installer icons will look similar to the

ones pictured below.
=
@ Installer Icol #‘

Installer Installer

Note: Inall cases itis recommended that any new software be installed with “extensions off”. When any installation |
complete itis recommended that your restart your machine and “rebuild the desktop”. These steps can greatly red
or prevent software conflicts that can occur due to improper installation (extensions on) or extensions conflicts.

The following pages contain configuration instructions for some of the basic internet software included on in
Midcoast Internet Solutions (Macintosh) CD-ROM.
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Personalizing Netscape Communicator

1) Start Netscape Communicator Undo 30 7
2) Go toPreferencesunder thé=dit menu
(See picture to the right) Cut #EX
Copy #EC
3) Select “Navigator” under the Category section to the Paste EY
left. (See picture below) Clear
Select All A
4) In the field next to “Home page location” enter
http://Mmww.midcoast.com (as shown below) Find in Page... % F
: i _ Find Again #G
5) Click the “OK” button at the bottom of the window. search Internet
Netscape Communicator is now configured! Search Directory.. =3%F

Preferences...

Preferences for MIS

— History
Vizited

Category :
= Appearance || Mawigator Specify the home page location.
Font=
Calors Mavigator starts with
— Mavigator {_) Elank page
Languages
dpplications !:' B
Smart Browsing™ () Last page visited
P Mail & Groups
[» Comnposer Horne page
[ Offline Ay : ;
b Advanced Clicking the Horne button will take wou to this page.

Horne page location: |htt|:| 28 Fwewew mideoast .com

[ Use Current Page I [ Choose Local File. ..

links expire after El days | Expire now

Help I [ Cancel ||m::|
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Personalizing Internet Explorer

1) Start Internet Explorer
2) Under the Edit menu select Preferences Cut EX
(See picture to the right) Copy #C
Paste Y
3) Select “Home/Search” from the menu on the left. Clear

(See picture below)
Select All A

4) Under “Home Page” enter http://www.midcoast.com ' Find... SEF
Find Again %06

Preferen=es...

5) Click the “OK” button at the bottom of the window.

Internet Explorer is now configured!

=——k———— Internet Explorer Preferences

You can customize the Home Page and Search Pages to open any

- 'web Browser
pages you want,

@ Browser Display

@ “web Content Home Page

i3 Horne /Search Your Home Page is the page that the browser goes to when you
click the Home button an the toolbar.

@ Language /Fonts

@ Subscriptions Address: |http:.-“.-“www.midn:uast.cum |

@ Jdawva

@ Security [ Uze Mone ] Usze Default ]

@ Security Zones [+ &utomatically go to this Home Page wehen apening a new swindow

@ Ratings

$ 2 hivanced Search Page

— Receiving Files Your search page is opened when you click the Search button an

the tool bar.

@ Download Options

@ File Helpers Address: || |

@ Cookies
- HNetwork

Uze Mone | [ Uze Default ]

@ Protocol Helpers

| | Cancel I | OK I
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Configuring Eudora Light (email)

1) Start Eudora Light d) Settings
02 = Real name:
2) In Eudora Light choos®ettingsunder = [Your Name Coptional) |
1 Getting Started POP account:
theSpeClal Contr0| panel R |username@midcuast.cum |
{Wour POP Account is your POP username
i followed by an '@ followed by wour POP
Filter Messages #1 PetsonalsIntorist ion server name. This may oF may not be the
Make Address Book Entry.. ¥K same as your return address.)
Find » % Return address ¢if different from POP account):
Sort b Hosts |username@midcnast.curd |
Filters I ! Connection method:
Mailboxes P [GR P -
s o s %L Checking Mail = () Communications Tool box
Directory Services 3y [ offline {no connectionss
C | 0K
Plug-in Settings [ 2 [ﬁj [—]
Communications...
Signatures [ 2
Change Password... i -
Forget Password A Settings
Empty Trash
5 .2
3) In the left window select “Getting Started” _ ||| RAEsccount:
A . . Getting Started |username@midcnast.cnm |
Fill in your information to match the 1st o
. . . eal name:
window to the right. You will use your own == Tfour Narms Captiomal) |
username in place of “username” on your Personal Information Return address ¢ if different from POP account?:
com puter. | user name & mideoast.com |
ﬁ Dialup username:
4) You will need to repeat this step under the ik Jser e |
“Personal Information” and “Hosts” as it is in
the 2nd and 3rd windows to the right. siinot B
Using Eudora Light
Cancel | 0K I
To get new mail waiting on our server,
connect to the Internet, select Check Mail from
the File menu. After entering your password, it: Settings

will connect to the server and retrieve any
waiting mail.

O

%

Messages retrieved from the server show uj
in the “Inbox”

8

To send a new message, choose “New mes
sage” from the message menu.

Eudora is a very versatile email program with
many features. To learn how to take advan-
tage of these features check out

www.eudora.com for a downloadable

!

ne

Getting Started

Personal Inforrmation

Hosts

h

W

Checking Mail

] »

FOF account:
|username@midcuast.cum |

SMTP: |midcuast.mm |

Fh: | |

Finger: | |

] DNS load balancing
[] Owerlap POPS commands for better performance
[ “Live™ Ph queries
[ Use mail-exchange records {SMTP Servers Only)

Cancel | 0K |

manual.
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Trouble Shooting

NOTE: All connection software is located in the folder titled “Mac Connection Software.”

ltem 1
Problem:No TCP/IP Control Panel present.
Solution: Install Open Transport

Open the folder “Install Open Transport” and then open the folder “Open Transport — Install First” then
double — click on the installer icon and follow the directions that appear on the screen. When finished
back to Step 1on page 1. ( For System 7.6 or higher, please read the note below.) You may then open
folder “Install second (optional)” and install a newer version of Open Transport if you choose.

Item 2
Problem: Either the PPP or Modem Control Panel ( or both ) is missing.
Solution: Install Open Transport PPP.

To do this, open the folder titled “Install Open Transport PPP” and double click on the installer icon, then follo
the directions that appear on the screen. When finished go back to step 2 on page 2. (For Mac OS8 or hig
please read the notes below.)

Item 3
Problem: My modem doesn’t appear in the pop-up menu in the Modem Control Panel.
Solution: Install additional Modem Scripts.

To do this, open the “Additional Modem scripts” folder and double-click on the installer. There is no need to
restart the computer after this, then proceed back to step2, page 2.

Note for System 7.6 users or higher ofiitye TCP/IP control panel is normally installed with your system software.
If you can't find the TCP/IP Control Panel, Then make absolutely certain that it is not present. To do this, pul
Down the “File” menu in the finder to “Find...” and let go, then type in TCP/IP and click on the “Find” button.
For OS8, reinstall from the system CD-ROM only.

Note for Mac OS8 users or higher onlyiese files are normally installed with your system software. If you can't find
either the “PPP” Control Panel, or the “Modem” control panel then make absolutely certain that they are not
present. To do this, pull down the “File” menu in the finder to “Find...” and let go, then type in PPP and click
on the “Find” button, repeat for the word Modem. If you still are unable to locate these Control Panels, reinst:
the software from your system CD-ROM only.
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